3 CUCMAIZEWindows CAIEH#E 1k
H

]

A

>

o

7 |\

off
SH
o
=S

v
7

AR

db =2 /=
B R1Ez§\

BLiE
Callmanager/Tomcat/TVS#E iR
|Psect& iR

CAPF&E#R

R PEEER

oana

S HEBR

b))

AN B EE T Windows ServerfiE Bl K HlF3(CA) LB HERN 2 ERE |, XEIEBER
HFEEMFE AP Cisco Unified Communications Manager(CUCM)IEH#IX.5097 B E R,

FRFH
EXR

Cisco BWIB THLUTEE :

e
R

. CUCM 1M1 5(N R E SR
. B E & Windows Server® I & ifi iR

fE AR A 4
AXEPHEERETUTHREMEERA
AP EEETCUCM 11.5(1) R E & R A,
. RE T CARSE B Microsoft Windows Server 2012 R2,

AXHEPNEEHRETREXRENEFNRZEEN, AXEFEANAAERZHRIERAR
(BN ) BE. MREHMNELTEIRES , BHRRETHEAARTHBELE,

HRER

BAREMMRENIEBTHAFCAZS !
IE$ £ F

MR
i

SR Y BR S5



ELZE R EMatiRM |, XS

EPEEFIFR(CTL/AZPE4ESIFK  -Cisco Call Manager
CallManager (ITL)X# , AT 5HMARS|(BIMN -Cisco CTIEHE R

ZE2FREPN(SIP)FH)HZ 2 -Cisco Tftp

X EH,

-Cisco Tomcat

omeat NELBIAEHBILHTTIPS)R -8 ABF(SSO)

Bigf, DB

\ AFAR
ATERBOXME  URSRER o

ipsec KEFIDHU(MGCP)HH323M XK <
IPZ'"zé(IIf’sec)i"ch Cisco DRF Local
CAPF (Jfg:c%ﬁk%ﬁﬂ’m BRI -Cisco i $AXRAKE I &%

AT HEBETERIUER IS

VS 32 5 (ST RS (TVS) M EEE,

BRMEERIERSS

XEFBHPE—NHE—EXS509 BEREZRE , &N , BT LR EMRS LBERE
RITH

EH X.509%4A A& X.509% RE4A A%
BFER .
‘WebfRS5 28 & 0 1 iE
CallManager -Z4AiN% _ s e
BFER _ o o
tomcat B NE w:gggigggzﬁg
BRI =
BFER ‘WebfRS5 28 & 0 1iE
ipsec A N ‘Web% i & 3 18 iE
BRI ‘IPsec iR R 45t
BFER _ o o
CAPF EHEH webg;?ﬁgggﬁ%
By X
Vs it Webf% 5 5 BT
: g s s

BXREAEE  FEARNS B EEESRREERN

[T

FB1:EWindows Server £ , S EIServer Manager > Tools > Certification Authority , 20B 7R



/content/en/us/td/docs/voice_ip_comm/cucm/security/12_5_1/cucm_b_security-guide-1251/cucm_b_security-guide-1251_chapter_011101.html?bookSearch=true#reference_0084C33783A0CE6C8A1097015629BEF7

§ Lo
hi A
"

¥ 2
N a
; 2
H

I

. T - -
Joir
Repr——
Ligan bz [ T—— =
o Al R iy .-
(R
o S e
R ancs W 2o o A A P
=
T L .
1=
.
. o ay Pl wud e
- - ‘-\.m..._
s

E=H  ABRENCA, RARSMENEFHENR  ARETIRFLEEEE , WEFT.

Fils Actios 'fiew [Help
e F 6w B
_-I_ {prbifeatnn Authonty Lol
i gl Colles Ca
Rwirhed Cortdie st
lowged Cartalicates
Fenigbny Firest)
Foded Brogueet
Cpetiic gt Templaing

Hasst

= capri

B CABECUCM

2 Tomaat CLACAS

v Darnctsary Frrud Replication

x| Boman Controbo Authenticaton
© Kerbreen Authenti sten

 EFS Recere rrp el

3 Baser EFS

2| Domen Contioler

5 Web v

L mipaad ar

o Lkar

= Susberdimabe Certdization Suthory

= Adrrenlrats

St Certdecnte Templaler inapn

_ bip

Callmanager/Tomcat/TVS#1}

E TR B BN E RCallManageriEtk By 82 ; 1B Al LUIRBAER B FZ TR A Tomcat M TVS RS I 2

e certsry - [Certification Autharity (Locall\Collsh CA\Certificate Templates)

= Lo

Irteraded Pusparst

Saprepd Rgtherdspnaen, P sudy dngd 5
bt Begthardsratann, B gacunty end ©
e Rgthared e S apn, [ keng Aathents;
Deractony Sarvicn Dmusl Replication
Cliont Authepnticstion, Sarvn Authonts
Cheont Authpaticsticn, Sarvnl Authents
Febe Ree érvery

Ea iyl enay Fabe Syt

Cleprd Sithebmbsc ph0e, Serop! digthents
bt B an s

Cleenk Aughepnbicabion, brvon Authents;
Engrypting Filg Systemy, Saoong Emad €1
o i

Policrgniol Tk List Segrang, Endnppling

T L}
Fatfacih

[aport Lt

L] L

PER ME—XBETEERN S R2P B H R R GE A8 BRI BRSS & 5o

S EIWeb Servert&itlk , ARRE T ZER , AGEEFREHEE , WAFR.



Faa  tn Nebm g
G EE UG

il sty Temglana jaon 1 lcollsbn Torpiae Dopley Hav T b Vi e, Geboded Fuepiries.
I Wortishon At e H WS Lk Authamirton

T v Sty ity [
Hha 1
3 Tam L Sy |
F Tomat £ H
B Skediast Tl bt I
1
[
1
i
F

x|
At
il
it
WS Ll Aubast s, e Authastoon

et el s

T rartord logon

3 Ry (D regai

T g (it pimis iy
3 e 185 Savenr

$5=% : #General T , B UERIEBERVER. ERBH, BRES.

SubjectMame | Sever | lssusnce Requiemerts
Supersaced Templstes | Edensions | Sacuty
| Compatidty | General | Request Handing | Cryptography | Kay Atestation

Templabe deaplay name:
|CallManager CUCM |
Termplabe names:
[CalManagar CLICM |
Wity penod.: Renewal penod:
L Sfirees  + L 6f[wesks |
[[] Publish cerificate in Active Drsctony
[ ] Do not automatically reenll if a duplcate certficate edists in Active
Derectony
| ok |[ Camcsl || Moy || Hew |

E=% . ST Extensions > Key Usage > Edit , B F 7R,



Compatibiity | Genersl | Recuest Handing | Cryptography | Kay Attestation

Suitwect Name Server |

lEsmnce Regurements

Superseded Templates | Ddensions | Secumty |

Ta modify an exdension. sslect &. and then ook Edi

Eﬂm%nﬂw:
Apphcation Policies

Bassc Constraints

Certficale Template infomation
lsusnce Polcies

Diesscription of Key Usage:

‘mmmmmmm
ﬁiﬂ‘ﬂm

| ok || cacel || Mot ||

Help

SBMUS  EFRXERTFEFOK , MEFR.

- BFER

AXAFERBAMBRTEAZSR (BAME )

- SV IR A P R




C ropemiesoiNewTempate [ X

Compatibity | Genersl | Raquest Handing | Cryptography | Key Attestation
SubjectMame | Server | lssusnes Requiements

Speciy the mouinsd sigratuns and securty options for a key usage
ES A

Signature

[+ Dageal sgnast.re

[] Sgrsture is proof of origin inorrepudiation)
[ Coicate moring

[ | CRL signing

Encnypiion

1) Alorw lomy mchange wihout ey snceryption fosy agresment)

(w1 Mow Rey exchangs anly wih key encryplion foy enciphesment]
] Ao mmcryplion of ussr dats

R Y e

| Ok || Cancedl || Aok || Hep |

FHL . SMEY R>BAER>EHESRN , WEFTR.



mlwlmwlwlﬁwm
Subject Name |

Superseded Terplates | Secury
T modiy an edension. selact §. and then chick Edt,




WMMMaMmE

Application polices:
Server Authentication

| Make this extension critical

$5% : #ZEClient Authentication , R ZENQ , HEZEAQMN L —NE O PIEEROK , MEFR

o



[ ok || ot || Moty || e |

ST 7REER |, EZFApply , RFIEFOK,



Compatibity | General | Request Handing | Cnptography | Key Attestation
SubjectMame |  Sever | lssusnce Rlequiements
__ SwpenededTomplastes | Edenmors | Secuty

T modéy an eermson, sslect i, and then cck Bt

Descrption of Appbcation Polcs:
Chent Authentication “
Server Authenbicabon

o

$ IR 8>x [ Certificate Template ConsoleE 0 , RAFREE —1NED , S ZEINew > Certificate
Template to Issue , ZIEF R,




Pl Agton  View  Help
e H oads B

L Cortification Aathosty Local)
4 g CollabCA
° Ervoloed Cortdfizsirn

3 carvz

H CaPF cuOM

 Tomoat CUCM

3 Dareciory Emad Replgaton

1 Bomain Cpnircliar Authenbcation
3 Kargros Authentication

3 EFS Retovery Agent

3 Bariiz EFS

3 Derrin Contralr

el Sereer

H Compues

3 fabpedinaty Catfiation Austargy
e

Createmt & nars #em in thes containgr,

My
5] Asherticated Seasmon
5 CA Exchangs

E CallManager CLICH

Selact one Cardiicals Template bo arabie on this Canficstion Authonty.

Piole: ¥ & cotficate tomplate that wis recently created doss not appear on thes list, you may need bo wal unti
infoemation about Bhes bemplate has been replcated io all doman controliers
Al of the cotficale femplaies in the organization ey nof be avadable b your CA
For more information, see Cetificate Template Concepts,

rtandad Pumposs

‘mlendrd Furpeae

Servir Suthosbeatien, P secuity ored 1
Berver dubepsin pleie, P pplusty el 4

Server Augheemir o, Dt SutSarsis
Doy St Errad Bl ghien

lprsd Rthprissstann, feroar Auibanbs .
Chard Sctharfscaton, Toreer Autbantic

Fie Fcomry
Endifppang File Tyitem

Tl Bethertstdiah, Sorver Autbaribg_

Server Authbste sl
it Regthandel gtag, WErver Lkl

[regrppiang Fie fystem, Secuse Ll {1

“ralls

b ropoft Trost Lint Sigeing, Encrypling

r: Il:irﬂ'l-uli-'l'nnﬂl:ﬁh'hnl

Chent Authenboation
Private Kay Archival
Server Authentication. Cheni Authentacation

Elnmc.um:mhmqr <Al

=] Ervolment Agent Cartficate Racusst Agert
3] Ervoliment Agent Compater) Certficate Raquest Agert
3] Excharge Ervclment Agert (e request) Certficate Reguest Agert
3 Exchange Signature Oy Secure Emad

] Evrhownn s B v Erru

e

| oK

|| Concd |

SRIRBEFZEENENABELR , ATomcatMTVSIRS BIRIEBER.

IPsectiR

SE1:HKEWeb Serveri&iiy , B2 T IZER , AR EREHEER , WEFR.




Faa  tn Nebm g
G EE UG

il sty Temglana jaon 1 lcollsbn Torpiae Dopley Hav T b Vi e, Geboded Fuepiries.
I Wortishon At e H WS Lk Authamirton

T v Sty ity [
Hha 1
3 Tam L Sy |
F Tomat £ H
B Skediast Tl bt I
1
[
1
i
F

x|
At
il
it
WS Ll Aubast s, e Authastoon

et el s

T rartord logon

3 Ry (D regai

T g (it pimis iy
3 e 185 Savenr

$5=% : #General T , B UERIEBERVER. ERBH, BRES.

[IPSEC CUCM

Torrplabe fume
[IPSEC CLCM

Winbchty peawiiced: Fianevwal panod:

L_2ywen | [_Fl[wosks ]

[ Publish cestficate in Active Directory

|| Do ot sutomaticaly reenrl f a duplcale cortficatle exisls in Active
Direciory

E=% . SMFExtensions > Key Usage > Edit , Z1EFTR.



Compatibiity | Genersl | Recuest Handing | Cryptography | Kay Attestation

Suitwect Name Server |

lEsmnce Regurements

Superseded Templates | Ddensions | Secumty |

Ta modify an exdension. sslect &. and then ook Edi

Eﬂm%nﬂw:
Apphcation Policies

Bassc Constraints

Certficale Template infomation
lsusnce Polcies

Diesscription of Key Usage:

‘mmmmmmm
ﬁiﬂ‘ﬂm

| ok || cacel || Mot ||

Help

SBMUS  EFRXERTFEFOK , MEFR.

- BFER

AXAFERBAMBRTEAZSR (BAME )

- SV IR A P R




C ropemiesoiNewTempate [ X

Compatibity | Genersl | Raquest Handing | Cryptography | Key Attestation
SubjectMame | Server | lssusnes Requiements

Speciy the mouinsd sigratuns and securty options for a key usage
ES A

Signature

[+ Dageal sgnast.re

[] Sgrsture is proof of origin inorrepudiation)
[ Coicate moring

[ | CRL signing

Encnypiion

1) Alorw lomy mchange wihout ey snceryption fosy agresment)

(w1 Mow Rey exchangs anly wih key encryplion foy enciphesment]
] Ao mmcryplion of ussr dats

R Y e

| Ok || Cancedl || Aok || Hep |

FHL . SMEY R>BAER>EHESRN , WEFTR.



Compatibity | General Hnumﬁlumulmm
Subject Name

Superseded Templates | Secusty

To modify an exdension, sslect i, and then chick Edit.




An application policy defines how a certificate can be
used.

Application polices:
Server Authentication

[ IMake this extension critical

$£5% : #ZEClient Authentication , %% © , AFEHOK , B R.



ok | Cmced || Mo [ Wb |

FR7BIOEEAN , BRIPREKIRRE  &FT , ARELEOM L —E O FEROK.



#n applcation pokcy (caled enhanced ey usage in Windows 2000)
defines how a cetficate can be used. Sslect the apploation poboy requrd
For walbd sgnatures of cedificabes imsd by this bemplate.

| 0K || Cacel || Mooty || Heb |

SR SRMERAR £ | EFApply , REEFEOK , MEFIR,



Compatbty | General | Reguest Handing |

WFM
Superseded Templstes | Edersions Securty

T modly an edenson, sshect i, and then chek B

Bxtensons included in ths template:
Appleation Policies

[Basic Constrmnis

Cartficale Tamplsbe famation
lssunnca Pobces

Ky Lisage

Descrpbon of Applcation Polices:

Chert futhertication ~
IP securty end system

Server Authenbcabon

[ ok || coce |[ moy |[ e |

$ I} 95X f] Certificate Templates Console®E 0 , AFREE—NEOD , SHEFINew > Certificate
Template to Issue , B PR,



L Cortification Aathosty Local)
4 g CollabCA
| Epocdopd Cerdfiz ey

3 carvz

H CaPF cuOM

 Tomoat CUCM

3 Dareciory Emad Replgaton

1 Bomain Cpnircliar Authenbcation
3 Kargros Authentication

3 EFS Retovery Agent

3 Bariiz EFS

3 Derrin Contralr

el Sereer

H Compues

3 fabpedinaty Catfiation Austargy
e

Createmt & nars #em in thes containgr,

intended Purpede

Server Authiatication, IF sty ol 1
Berver dubepsin pleie, P pplusty el 4
Server dusthsbmin gl Clotyst GufFaing
Depcicey St Emud Egpla; ghaen
Clerst Sathardsstan, Seror Aufanbs
Clgrt Ssthantication, Soreer Authantic
Fie Fcomry

Cltrel Rothanalian, Sercer Lt
[regrppiang Fie fystem, Secuse Ll {1

“ralls

b ropoft Trost Lint Sigeing, Encrypling

ri Icﬂuttﬁvﬂu‘uhﬁn]

SR 10EZEFHIPSEC CUCMER , AEEEHE , WEPR.

Sglect one Cenficate Template fo enable on they Certification Authorty

Hote: F a cetificate templabe that was recently orealed does not appear on this bst, you may need 1o wall unti
rhormaten sboal s bemplabe Fas bean repbcated b 8l doman controlens.
Hﬂhcﬂmmnhmmmhnﬂ:iammm

For more informaticn, see Certificate Ternplate Concepts.

CAPF#itx

SRR IBCABERAGRE T, ARFEFEDuplicate Template , Z1EFT o




s Enee Wes g
s T Es 0=
& Biten (g il 1 LA
= I
[t ad B e 1 TR I e e .
0 Mg Ly I Wiy G METwin
(L] i R Faggrrin. et Lo g, ek
g gy b i L
T e ) i LL " ] Hetp ey i Ll s, D &
I Do t [T [Fye—— ik
[ — i LE]
L 1 8]

Valdity peniod: Renewal penod:
| Slwean |__6||wesks |

] Publish camtfizals in Active Disctory

] Do not automatically resrrol i a duplicate cortficate exists in Active
Dt oy

#£=% . SME|Extensions > Key Usage > Edit , 1B,



Compatblty | Gened | lssuance Requimments
Superseded Templates | Edensons | Sacy
To modify an edension, seact 1. and then cick EdE.
Edensions included in this templale
| Cemficate Template fomation
Description of Key Usage:
ww: ~
[‘.HLm.
Crivcal extension,

| Ok || Comcd || Aoy || Hep |

SBMUS  EFRXLERTFIEFOK , MEFR.

- BFER
- EBER
.- CRLEH



C ropemiesoiNewTempate [ X

Compatibity | Genersl | Raquest Handing | Cryptography | Key Attestation
SubjectMame | Server | lssusnes Requiements

Speciy the mouinsd sigratuns and securty options for a key usage
ES A

Signature

[+ Dageal sgnast.re

[] Sgrsture is proof of origin inorrepudiation)
[ Coicate moring

[ | CRL signing

Encnypiion

1) Alorw lomy mchange wihout ey snceryption fosy agresment)

(w1 Mow Rey exchangs anly wih key encryplion foy enciphesment]
] Ao mmcryplion of ussr dats

R Y e

| Ok || Cancedl || Aok || Hep |

FHL . SMEY R>BAER>EHESRN , WEFTR.



mlwlmwlwlﬁwm
Subject Name |

Superseded Terplates | Secury
T modiy an edension. selact §. and then chick Edt,




An application policy defines how a certificate can be
used.

Application polices:
Server Authentication

[ IMake this extension critical

$£5% : #ZEClient Authentication , %E© , RAFEEOK , B R.



ok | Cmced || Mo [ Wb |

SR 7. BREREAND , BRIPREKRARE , EEE , ARELEOMLE—MEOLEEREOK , WHE
PRt 7Ro



#n applcation pokcy (caled enhanced ey usage in Windows 2000)
defines how a cetficate can be used. Sslect the apploation poboy requrd
For walbd sgnatures of cedificabes imsd by this bemplate.

| 0K || Cacel || Mooty || Heb |

SR SRMERAR £ | EFApply , REEFEOK , MEFIR,



Compatbty | General | Reguest Handing |

WFM
Superseded Templstes | Edersions Securty

T modly an edenson, sshect i, and then chek B

Bxtensons included in ths template:
Appleation Policies

[Basic Constrmnis

Cartficale Tamplsbe famation
lssunnca Pobces

Ky Lisage

Descrpbon of Applcation Polices:

Chert futhertication ~
IP securty end system

Server Authenbcabon

[ ok || coce |[ moy |[ e |

$ I} 95X f] Certificate Templates Console®E 0 , AFREE—NEOD , SHEFINew > Certificate
Template to Issue , B PR,



bl Raotsan  Vesw  Halp
e 7| a s B

et ere Tarnplebe

Cinatwn & npws @om in ths containar.

¥ Karsaron Authentis stion
3 EFS Retovery Agent

L) Cortification Sesthosiby [Local) Hame intended Purpeds

d gl CollabCA 3 CAFE2 Server Suthiein sbien, I vodurty ored 4
Farozdord Certifizaten B CaPE CLIa Serwr Authebsld Bloe, B Lbustly 0l £
K prtfa] popt B Tomoat CUCM Servdt digThebabed giapn, Clnpat bt
P = .
b Petpstils 2 Derpstony Ermad Bapla; sbhaon Deecioey berveot Emad Bl phaen
Fusid Raqurit: -I Domain Condrgllr Aughenbs shon L karel Actharde sfan, werear hytbgnbc

L Apthanisstaon, Seregr Authanibic_.

Fi Fircomnry

3 Briie EFS Endifppang File Tyitem
3 Derrin Contralr Tt Bathentssfoon, Sorver Sutbamrs
= Wtk Seres Servtr Authtat on
H Compues Ll Bt o faiety, SEfedd Aifthalesisl
3 Y Lrepryphang Fie Symtem, Secuse Dergal, {1

1 ke sty et b AuERo sy
3 Adminabce

Felanmgr

Espeast Lk
Vet

Aty o
Lo i lopns
Helg

il

b ropoft Trost Lint Sigeing, Encrypling

k [l:l'rH'H.lll: im-pl!l-:lulnu:]

SRR 10iEZFHICAPF CUCMEELR , ARFEEOK , IEFTR.

-
L

Mote: F o cetificate bemplabe that was recently created does not sppear on thes st you may ressd bo wak untl

Enable Certificate Templates
Zeiact one Cantficate Template o anable on this Canfioation Autharty

mfomaton sbout s template has baan epbcated 1o sl doman controlears
Al of the cestificate templabes in the onganization may not be awalable to your CA.

Far mare indammaticn

fee Lerfdulple Templite Loncept

" certsre - (Centification Authority (LocalCollab CAYCertifiate Templates) =15 IR |

Hmre i ended Pupose -

5 musherteated Sesmsen [l Sgbasntas st

¥ CA Exchange Frivate Key Archeal

E = | | E

3l Code Sgning Code Signing

3] Croas Contibcation Autheety <Al

7] Ervolment Agent Cestficate Fequest Agert

3] Ervolment Agent omputer] Cerficate Flaguest Agert

7] Excharge Sgnature Orly Secure Emal

5] Exchange User Secure Emad

%l PSac P securty |KE rismmadate

W PR TN T By i atioe [P s ity el metvsm i S Fhasrdir b gt
oK [ Cance

ERIEHZRHER

{55 FA bk 7 51 BT 455 A 7 2 B AV A8 AR 4 A CallManageriE . #HENSBRUA FEMIERERE  £RE
8 R 35 $RAUE P AR AR R -

FET|1.FECUCM L , S FOS Administration > Security > Certificate Management > Generate
CSR.

BoH  ERXERMAREER , WEFTTR.



. iE$ A% : CallManager
- B <XTRRA AT AR , b TSUH T SSAN>

v alee Lo bae Sl i W ejmear

[}, o [T cone

- SLabas
‘_Eu:rrin-u'{-vﬁmnwn CER a3 dpeiliflel (il gk CyTet will Gorbimaring thed i {5F fod BAaL Tuek

- Canevaie Certillcadn Risquieat
et Piad i " ¥ [T ETER T
Ceipiriptian it -garver] RAN ) v
Common hams® 11 3PUB-mp mascatal b
Sebjecd AHevnabe Hamay [HARL)
Aoz populnied Dormusina § T e abal h

LO25UE roie sl Lol

Farird (DEnEn sl Lt
Cithui® Cuiea vk - Chgdi i By (el
Fiaans mpart  THT 2le omly,
it i bl Ttk Dheass FEbel 10 i redis b the
Flp Spilfen
L]
Wiy Tirgsh™ ™ L2
Ky Livsgth® aHE ks
Hapn abgorivhen ® SHAT T
(v g Pt ]

B=F  REERBINVER , WBAR.

LGenorad o Corl#@ ale Sigrineg Bogeeesf

W L

Ll 0
@5&1"“: Corlfefln Sgyung Beguanl Sanerifed
m CHE woport cparation puccsaniul o the nodeer [ 51 SPULmescabul lsl, 1560 maucaial lab].

EHL  HUEBIIRP , EHRRENCSROnlyWHREHEEE , MEFIR.

&5 . wee [ liy
= |

| CenEcstein (1St 360 By g Page na 7
T CHmfnicd L =THE LT T | Pl Clead T o e
sy g T Vo Tapm ; Frariinin ami B Aeprw e o
iy BITHE Gl Ll LT 12 S ] il Ll MITHE_ i CAFRIIOE el el TR b
saegrd e
L v B4a
1T S il Ll CUPE T Rl iail it e failind
el i ]
[t o siihak e R . BL L B 13 S PAE] - T R
T ek [ ] M e L A
Loy ol LLIFSE BT e afal Uk el Lo 1 MR e il Lk 119 BT Trgal Dol i
et} A =g ag b

SBhHY  HREEOR , EFETRCSR , /XM EREFIUTEN L



CSR Datails tor 115PMIB-ms maucalial lab, CallManagar

b [:ﬂnu-mnm

- Certiflcate Settings

Flle Mame CallManager.csr
Cartificile Purpaie CHlMBRaGET
Cartificate Tyoe carts
Cartificate Growp praduct-£m
Description|frigndly name)

- Certificate File Data

PECS1D Rpguast: [ =
wersion: 0
Subject: CH=115FF8-ms.maucaballab, OU=dsco, O=dsco, Leddsco, ST=clscn, C=Mx
SubjectPelinfo: FSA [1.2.840,11354%,1.1.1)
Ky valug:

B0 L0A0TE20LI000C L Sas ) 1064 5002 ! 1etactaz 340 3466516047 701 7005303 de7d
cabel 4SS S3Gele S HdE 207 Iddead IO Soe00 1 207 74802 03 20T 2174 14 10T 00 34
02T redee S 5d et a4l 000N e ol bEf40ad9 3302 124 14468 1917 P IbE Rdalb P ata2 de Tdd 2dd2
Hbd3dSaan5M4M022 37ecabca T4l a2 d0b46 3805 canPee ] TLABIE 30623 20coDaTdodldcTsh
TOdes1 SHIPSISA0A080 3008441 1732084 ac T biS4acabad 361 L EEI0aE 2802303000
Ghed 10eddb4e 11 880 bed 09848 20060 190 Hd 3 1 a8 ddd e Sef B T 3445 Tha ko 2 144
a6 7 e ST 2Eb5ab0SEThIIO2 73538 edeesdT ] A6 Fd TEb0ce 1a L bASE 2 36081 1 Shac
EB25a 0 7eB4ca0 203010004
Attributes: |

Requested Extensions | &

Delete | | Downlosd C5R

FBAL  EXNRSFL , SMBEBLURL , AERMABEHREERER
. https://<yourWindowsServerlP>/certsrv/,

SR 7. SMEWREB>BREEHER , WERR.

U Bhils. Wby 58w b resquies] 2 cerificate for your Web browser, sumad clent, or offer program. By using & cericale, you can verlly your kenily
W PR O COPTHTARCINE W Cher T WD, IO a0 STV TkaBgES, B, OS] L T feps of CerpfCans you ejussl [T
et dorirtty L

s £ ey s Bhis YWl e bo Sownica] 3 ceriEicate Eahorty (A cerifcore, caniloate chain, of certfore nevncataon B | CRLL of fo vy
W LA O @ [eTRI MEU

For mom informaton about kotvn Diencory Cortificale Serdons, s Acthp Dirpclory Corbficite Serviors: Dosumentation
(Eos s ]

W the Rt of 3 pondhng ceificatn requeH

Demnioged 3 & cerificale. covificaie chain, or CHI

[ marnest A Doty Cotbcte B Cobeca e
Requadl o Cortificats

Trincd tha corbficale fpo
Wger Corpioans

ox. fatrancod cor regurit |

SR BITHCSRXMHHEHEMBAR :



Fia [ Formaf Waw hip

----- BEGEH CORTIFICANE FLQUEST - - - - - MOI DR, CilbodC dact [ & PUIG VLI BiMC Thigral) | A0Mghe Tl T Mg 1w MOMID FIAOGHT w' )
ARl EOPa A U e w ) | W D Bl § SMEE AR T e MR SR o W TP | 0 Bl | W F | Wihny b3 F EME 1A jonBghighi |
S AN LM T8 0L Al B i T L0 7ol o D T 1 AN NS S 3 BRI E T SR T g F 1 SapiDin 12 kPR a0 8 ddyrwficw
TR PP, ) B 570 i 3 08 T oy ] T MG F YT 9 T ] Dyl Tl 480 T o 1P b v TP Tl B F PP o LR il
2651w VO L2 s OQLE ERDE fL e aKE DR e peof YR s ool TofmmD ek EOH T E M d cnB0umt v Sant /4 § Gof ShXPLrr L IS qH TRa G FUR S
i Tt TN T30 JuTHE ¥ ] 2 o MOl kel ] 2P G Do el QT et ] GRG0 S ] e DOKH 0 F i Bacb VTG | Y Y E I YIRRCH)
i G AT Bt A4 1 a3 A F 48 BB R 0 28 e M TV T b B2 E i § MM TV T el 17T 4 Wbl L
VNN T WSS A PHE D N2 e UM DA AT gt ML L il oS 1.7 E B i O 0 it 5 T yird UM 55 Aot p  000n ke 3
AP0 W o v T S TR0 B T S L bl T il A P E D 2 o b Wil i v | S0 b Dy Ol Sp fw ILE PR g frpll ) 1 20
Loy T B 3 Dot Doy BTV, T gl T Lot 14 G TAK e T Saushui 1 B 7 3 oy B L P = oot e £ T remUucn Lo ofily
1180 S P 1 PO i el 3. 3 TR IS L i 7 B e 1 T Tl e g - - - - - EHG CPRTRFICATE BLQAMEST-----

S| OFCSR¥E M ZIBase-64RMBHEHWRFER T, HIEPERT , R EHHOER , REEER
#’X , WERFR.

Bt & Cormricate Regqonat of Fefeeal Reguetl

T el & v Sl 10 T CA, padte & baso-Sd-arended CIC of PRCS 170 corSieate mgues! of PRCS T serirwdl iogued? (ofhi stod by
an pasernal sodrce |sch 38 3 Weeh wsrenr) in the Saved Requet baox

Mol Eepemal,
SRy S T el My T -

Barer-t--praemd @7 S e Ty i e e ekl i

et g g T erealprsy

FRAT Lrp b phodmi i peasri el 107

PR # gy

T ) SeaopEy SIRTIFICAST RDgURNT:iss: -
[ "

Sorsfcuis Tempiria:
Ll srager TLCH

Ay

SR 105%/5 , it#¥Base 64 encodedF1Download certificate chain , IR 1E A] LU 4 B Y S04 E4& Z
CUCM,

Sertificate veued

The: perificale you requesied was sued oy

CIDER Sfetitd of 8 Bk 84 ertintend
Coverieaal Gorpiats
EWWW

L4

WIFIERPR EREESEN —Eo

B HERR

HEDZ AT T E BN B EREHRE R,



XFHEE
BRRAA IR SHSBEEL ANV RIERTRES, FELRUAFPEETS
AHEEBEITISHINE.,

IR MEERIFANSEE, HEREUARTENIFARRIKYE.

Cisco Systems, Inc. ¥ FENFRVERMERNAIBEMSRE, HFRNECERSEEXRAXY (BEiRfH
)



